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Using This Manual

Introduction

This manual contains step-by-step instructions on how to perform certain processes. You should be aware 
that each exercise provides a single path through ERDAS IMAGINE® tools. In most cases, there are vari-
ous ways to maximize tool usage, depending on the individual project. 

This exercise manual is provided to the student, along with all images and copies of the presentation slides 
used by the instructor. This provides the capability for recreating the processes performed in class at a 
later date, as well as the key points on any theory involved. 

Exercise Conventions

Section Title Page States the objective of the exercises and lists the application tools to be utilized 
within the various tasks.

Exercise Tasks Each exercise is split into a set of tasks. After the course, these tasks will help you 
locate within the manual where you performed a certain set of steps.

Challenges Challenges are extra exercises which are included as bonus exercises. If you fin-
ish an exercise early, please feel free to move ahead and tackle the Challenge.

Questions These appear in a larger font with both bold and italic attributes. The instructor 
may quiz and/or review with you, following each exercise.

Class Notes  These pages follow the end of each exercise on which notes from your studies can 
be made.
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Notational Conventions

Bold Italicized Text Any text, which is bold, indicates a filename, or parameter to be changed or 
selected. 

Graphics To help you locate icons and objects used in the exercises, the icons will be next to 
the icon name in the text.

Insets These italicized captions will appear in the outside margin of the page. They define 
terms or explain theory behind the steps you are being asked to perform.

Diagrams These are an optional means to direct you in the usage of some of the applica-
tion’s tools.

The following graphics are also used for particular purposes:      

This is a note or a quick tip. It gives additional relevant infor-
mation, or describes other ways of using the software.

This is information relating to the application of the current 
tools. 

This is a reference. It provides additional theory or science 
that will help in using the tools.

This is a warning. It cautions you regarding potential pitfalls 
and how to avoid producing errors.
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Windows Terminology

Title bar

Open file button

Radio button (enabled)

Radio button (disabled)

Text box with nudgers

Popup list

Checkbox (enabled)

Button (enabled)

Button (disabled)
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The eWorkspace

Quick
Access
Toolbar

Title bar
Active Layer type

Hidden
panel

Docked
panel

Ribbon

2D View Status Bar
Map View
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The Ribbon Explained

Group

Collapsed
Group

Expanded
Group

Unselected tab

Properties button

Selected tab
File Menu
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Section 1:  Data Visualization and Manipulation

Objective 

To use the ERDAS IMAGINE© Viewers for visualizing the various types of raster data and to manage vec-
tor coverages. The student will also execute the workflow to create an image mosaic and a map composi-
tion.

Tools Used 

Viewer  Used to visualize data layers, zooming, inquiries, setting scales, and measuring.

Raster Options  Tools to manage display settings.

Attribute Editor  Tools to display and edit characteristics associated with raster and vector cover-
ages.

Vector Viewing 
Properties 

Tools used to change display settings associated with vector files.

Mosaic Pro Provides a method of piecing together images in order to create a larger image.

Map Composer Used to produce map compositions from imagery and any other information.
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Exercise 1: The eWorkspace

Objective: Students will gain an understanding of large-scale data through the use of the 
eWorkspace. Students will use the Viewer in order to visualize raster data from dif-
ferent sensors, and overlay a vector coverage. 

Task 1:  Display 
Data in a Viewer

1. Start ERDAS IMAGINE©.

The ERDAS IMAGINE eWorkspace opens.

1
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2
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2. From the eWorkspace, click the File Menu. From the menu, select 
Open  Raster Layer. The Select Layer to Add dialog displays. This 
dialog is used throughout ERDAS IMAGINE.

1) File Menu Access to New, Open, Save, View, Print, Session, 
Batch, Configuration, Preferences and Help.

2) Quick Access Menu One-click access to commonly used functions. 
Customizable.

3) Ribbon Access to IMAGINE functions, collected in tabs and 
groups

4) Title bar Window Title, Window (Viewer) display icons: Minimize, 
Maximize, Close

5) 2D View Main Viewing space. Can add multiple views, Map 
View, 3D View.

6) Contents Pane Display and arrange all layers each View.

7) Retriever Organizes easily-accessed shortcuts to your data and 
Web Services.

8) Status Bar Cursor identification and image coordinates
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Continuous data - 
quantitative data that 
have related, continu-
ous values

3. Ensure that Files of type is set to the default IMAGINE Image 

(*.img). The icon next to the drop-down menu  allows you to 

change the default file type.

Thematic data - quali-
tative data that is cate-
gorical

4. Navigate to the course data directory (e.g., c:\train-

ing\fundamentals1) and click the  button on the upper-right hand 

corner of the dialog to save the current directory as the default input 
directory. This path is saved in your Preferences.

1

2

3 4

7
8

5

6

1) Look in Changes the drive or directory.

2) File Selection Area used to select individual files in current directory.

3)Set Default Data Directory Save the current directory as the Default Data Directory in 
the ERDAS IMAGINE Preferences

4)Set Default Output Directory Save the current directory as the Default Output Directory 
in the ERDAS IMAGINE Preferences

5) Recent Lists the most recently used files.

6) Goto Lists the most recently visited directories.

7) Files of type Selects the type of file to be opened.

8) Preview Previews the selected file, when available.
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5. Locate and single-click on the continuous layer tm_00.img to high-
light it in the File Chooser.   

6. Click the Raster Options tab to examine the display parameters, and 
confirm that the Display as default is set to Pseudo Color. 

Raster layers can either be raw/multiple layer continuous 
data, single layer panchromatic continuous data, or cate-
gorical/single layer thematic data.

Landsat Thematic Mapper (TM) imagery contains 7 bands 
of multispectral imagery at 28.5 meter resolution. (The 
image you will view has been resampled to 30m and the 
Thermal band, band 6, has been removed.) The image 
bands range from the visible to the mid infrared. Imagery 
from Landsat 7 also contains a 15 meter panchromatic 
band.

If the desired option is not selected, click the pull-down 
arrow for Display as and select Pseudo Color. The choices 
are: True Color, Pseudo Color, Grayscale, Relief. 
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7. Click the Multiple files tab to examine the options for bringing in mul-
tiple files into a single Viewer.

True Color Simultaneously displays continuous layers (or bands). 
Each layer is associated with the Red, Green, Blue 
color guns of the monitor. The intensity of each color is 
controlled by the values in each layer.

Pseudo Color Displays thematic images (classified) by associating 
each class value with a color; single layer.

Grayscale Displays one continuous layer (band). The band values 
are associated with a grayscale. Low values = dark; 
High values = bright.

Relief Used to display elevation data. Requires extreme varia-
tions in pixel values.
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8. Click OK and the image displays in the Viewer.

9. To quickly display the Viewer options, right-click in Viewer #1 and 
select Fit to Frame.

Multiple Indepen-
dent Files

Brings in files, individually, as separate layers that can 
be arranged or deleted separately from the other files in 
the Viewer.

Multiple Images in 
Virtual Mosaic

Individual files are treated as a single logical file (or 
layer) in a single Viewer. Contrast options apply to all 
images in the Viewer.

Multiple Images in 
Virtual Stack

Allows you to bring in separate multispectral bands (i.e. 
LANDSAT 7 TM) without requiring you to have one 
image with multiple bands. With this option, the sepa-
rate files can be selected and ERDAS IMAGINE will 
dynamically combine them in the view pane so that they 
can be manipulated as one single image.
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This option can be selected in the Select Layer to Add dialog. 
When displaying an image, click the Raster Options tab and 
enable the  checkbox before clicking OK. 

You can also select Fit to Frame button  in the Extent 

group on the Home tab.
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Task 2:  WorldView‐2 
Data

Next, we will examine WorldView-2 Data to determine which image will assist us 
the best in our study. The level of detail the WV-2 image is greater than the LAND-
SAT, so we will open a WorldView-2 satellite image, which contains more detailed 
information.  

1. Click the Open Layer icon  on the Quick Access menu.

2. In the File Chooser, navigate to your Input Data Directory and select 
seattle_wv-2.img.

3. To zoom in to the image, position the cursor over the area you want to 
zoom in on, and scroll the mouse wheel up. 

4. To zoom out, scroll the mouse wheel down.

5. Use the Interactive Zoom In  and Interactive Zoom Out  
tools to draw a box around the areas you want to view. 

WorldView 2 imagery contains 8 bands of multispectral 
imagery at 1.66 meter resolution. The image bands range 
from the Coastal Blue, Blue, Green, Yellow, Red, Red Edge 
(on the edge of the visible red range), and two Near Infrared 
bands. Imagery from WorldView-2 also contains a 50cm 
panchromatic band.

You can also select the desired layer in the Contents pane, 
right click and select Fit Layer to Window

Additional Zooming tools are contained in the Zoom Tools 

menu. To access them, click the menu arrow  and then 
select the tools you would like from the menu. 
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6. Click the  Previous Extent button. This icon will step you back-
wards to the last zoom level. You may undo all the way to the original 
zoom level used when the images were opened. 

7. From the Scale and Angle group, use the thumbwheel to zoom out 
and back in to the image.

8. In the Viewer, click on the pull-down arrow from the icon panel and 
select a scale of 1:1000000.

9. In the Viewer, hold the middle mouse button down and pan through 
the image.

10. From the Viewer tool bar, click the  Pan button. Notice the pointer 
changes to a hand when in the Viewer.

11. Click in the Viewer while in Pan mode. This will change the icon to 4 
arrows. 

12. Using the Virtual Roam capabilities of ERDAS IMAGINE, roam across 
the image to the State of Washington (in the northwest corner) by 
moving the mouse in that direction.

13. Left-click in the Viewer again to turn off the Virtual Roam mode.

Task 3:  Add a Second 
Viewer

Open a second viewer to examine the WV-2 data in greater detail.

1. In the Window group on the Home tab, click the  Add Views but-
ton. Select Display Two Views from the Add Views menu.This will 
open a second View within the eWorkspace.

2. Select View #2 by clicking inside the View, or by clicking on 2D View 

#2 in the Contents panel. Click the Open Layer icon .

Besides using the variety of pre-selected scales and per-
centages, users can also type in a particular scale in the 
window.
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3. Click the Goto button and select your Fundamentals course data 
directory.

4. Change the Files of type to All File-based Raster Formats and 
select the seattle_wv-2.img image.  

5. Click the Raster Options tab, enable the Fit to Frame and Back-
ground Transparent checkboxes.

6. Click OK.

Is the image thematic or continuous?

Now, you will set Preferences for Default Directories and Raster Options.

7. Click the File button and click Preferences. The Preference Editor 
displays.

8. In the Category list, ensure User Interface is expanded and the 
User Interface & Session category is selected.

9. Ensure that the Default Data Directory, displays the path to where 
the course data is located. (Your Instructor will provide you with this 
information.)

Search for
preference

Clear Search

Browse for
Directory

Preference
has been changed

Save preferences to
User directory
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10. In the option for the Default Output Directory, ensure that the path 
to where all images generated in the course will be saved. (Your 
Instructor will provide you with this information.) 

You will now set the Raster Option preferences so that Raster Options dialog dis-
plays with the Fit to Frame and Background Transparent options set as the default.

11. In the Category list, expand Viewing and select Viewer. The prefer-
ences for the Viewer display.

12. Scroll down (vertical scroll bar on the right side) to the Clear Display, 
Fit to Frame, and Background Transparent options. 

By default, the Fit to Frame option is disabled. 

13. Enable the Fit to Frame preference.

14. Click the Save button, then click Close.

15. Select the Viewer containing seattle_wv-2.img, and then click the 
Open Layer icon .

16. In the Select Layer to Add dialog, navigate to and select tm_00.img 
again, and then click the Raster Options tab.

17. Disable the Fit to Frame checkbox, and then click OK.

18. From the 2D View #2 group in the Contents panel, grab the World-
View-2 image; drag and drop it to the top of the stack.  

What is the purpose of the Background Transparent option?

19. Set the scale to 1:100000.

Compare the TM to the WV-2 image. What features can be deter-
mined?

To determine the best image for identifying certain elements within an image, it is 
useful to change the band combinations for multi-band data (e.g., LANDSAT TM).

20. WIth 2D View #1 active, use the Fit to Frame tool from the Extent 
group and select tm_00.img in the contents list. 

Alternatively, in the Select Layer to Add dialog box, navigate 
to the directory you would like to set and click the default 
data icon  or the default output icon  to record the cur-

rent path in the Preference Editor. 
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21. Click on the Multispectral tab to display the functions associated with 
this type of imagery.

22. From the Bands group, use the popup list to change the band combi-
nation to Red: 5, Green: 4, Blue: 3. This is also known as 5,4,3 
(R,G,B), or a TM False Natural Color band combination.

What features does this combination enhance?  

With regard to the TM data, which band combinations provide the 
best identification of:  Clearcut areas?  Rivers?

23. Change the TM Band Combination back to 4, 3, 2.

24. Select the second (WV-2) View. From the Multispectral tab > Bands 
group, change the Sensor Type to WorldView-2 Multispectral.

25. Select TM-Style False Color IR from the Common Band Combina-
tions list. The color combination of the WV-2 image should closely 
resemble the color combination of the TM image.

With regard to the WV-2 data, which band combinations provide the 
best identification of:  Vegetation?  Rivers?

26. Click File  Save As  Session....The Save As dialog displays.

27. In the File name text box, type WV2_TM and press Enter (the *.ixs 
extension will automatically be added to the file name), then click OK.

28. Close 2D View #2 by clicking on the  in the upper right corner of 
the View.

You can apply different band combinations until you can 
clearly identify all the important elements required. You may 
use different band combinations for different elements (e.g., 
vegetation and rivers). This will be covered in more detail 
later. 
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29. Clear 2D View #1 by clicking the  Clear View button in the View 

group of the Home tab.

30. Clear any open Views.

You can also clear the view by using the Clear View button 

 on the Quick Access Menu at the top left of the eWork-
space.
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Challenge 1: Creating and Using a ShoeBox

Objective: The student will create a ShoeBox and organize project data without physically 
moving it—which could have adverse effects on others trying to access the same 
files.

Task 1:  Create a 
New Shoebox and 
Add Files

The ShoeBox is a small XML file that contains the Group names and absolute 
paths to the data.

1. In the Retriever pane, right-click and select Add New ShoeBox.

2. Right-click on the new group (currently named “Shoebox”) and select 
Rename.

3. Change the name of the ShoeBox to Wynoochee Salmon Risk 
Assessment and press Enter. We are ready to start adding files to 
the ShoeBox.

4. Display tm_00.img and seattle_sub.img in a 2D View. Make sure 
seattle_sub.img is the top-most layer in the Contents pane.

5. First we will create a group to hold the images. Right-click on the 
group and select Add Group... Rename the group Seattle. 

6. Add another group and name it Landsat TM.

7. You can drag the top layer from the View directly into the shoebox. 
Drag the top image (seattle_sub.img) from the 2D View and drop it 
into the Seattle group. 

8. Now select the tm_00.img file from the Contents pane and drag it 
into the Landsat TM group.

9. Now we are ready to add several files to the Shoebox at once. First 
we will create new groups to hold the data. Create a Terrain and a 
Soils group.
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10. Right-click on the Wynoochee Salmon Risk Assessment group and 
select Add File...

11. Browse to your Fundamentals input directory and use Ctrl + click to 
select dem_99.img, seattle_msi.img, seattle_pan.img, 
soils_95.img, subset_tm_00.img, and subset_tm_88.img. Click 
OK. All of those files are added to the top-level group in the Shoebox.

12. Drag the dem_99.img file into the Terrain group and the 
soils_95.img file into the Soils group. 

13. Rearrange the groups and continue organizing the data until you are 
satisfied.

Task 2:  Adding Other 
File Types and Viewing 
the Data

1. Now we will add vector data to our ShoeBox. Right-click on the top-
level group and add a Hydrology group.

2. Select the Hydrology group and then right-click on it. Select Add 
File...

3. Change the Files of Type to Shapefile (*.shp). Browse to the data 
directory and select hydro_00.shp and wynoochee_drainage.shp. 
Click OK on the File Selector dialog. The vector files are added to the 
selected group.

4. Expand the Terrain group and drag the dem_99.img file into the 2D 
view. Drag other files into the 2D view.

5. Right-click on the Top-level group and select Add New Outputs. 

The Shoebox will save the absolute paths to the files that 
you select here. If you want to share this ShoeBox with 
other people, you may want to browse to those files using 
UNC paths (or another means of accessing the files from 
other computers).

For instance, instead of browsing to C:/SharedFolder/File-
name.img, you should browse to //ComputerName/
SharedFolder/Filename.img.

The Outputs group will collect all of the files you create 
throughout the course and add them to the ShoeBox. You 
can then drag-and-drop the output files into their appropri-
ate groups.
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6. To save the ShoeBox, right-click on the top-level group and select 
Save as ShoeBox file... Browse to your Outputs directory, name the 
file wynoochee.ixp and click OK.

This ShoeBox contains most of the files that you will be using for the remainder of 
the class. Feel free to use it and add to it throughout the course.

7. Clear any open Views.
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Exercise 2: Basic Change Detection Using the Swipe Tool

Objective: Students will perform visual change detection by loading multiple images into a 
View and use the swipe tool to view the underlying image.

Task 1:  Using 
Swipe to Examine 
the Images

1. In a new View, open ortho_2006.img and ortho_2009.ecw.Ensure 
that ortho_2006.img is on top in the Contents pane.

2. Zoom in a little so you can better see the empty lots.

3. Uncheck the box next to ortho_2006.img in the Content pane to 
undisplay that image and see ortho_2009.ecw beneath it.

4. Use the checkbox to toggle the 2006 image on and off. When done, 
make sure that both images are displayed.

Now we will use the Swipe function to see the changes.

5. Start the Swipe Transition layer by clicking  Swipe button from 

the View group of the Home tab. The Transition tab is added to the 
ribbon and the Transition Pane is added to the left of the viewer. 

You can also right-click in the 2D View and select Swipe 
from the Quick View functions. Blend and Flicker are also 
available options.
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6. Use the slider in the Transition Extent group to swipe the top layer 
back and forth and examine the change.

7. Right-click in the View, select Open Vector Layer, and add landpar-
cels.shp to the same View. You will now have three files and the 
Layer Control group updates accordingly. 

. 

8. In the Layer Control, move the check for ortho_2006.img to the W 
column to make this a Working layer. Use the Transition Extent slider 
to swipe two layers.

L Locked The status of the selected image is locked. During a movie the 
status of the image remains unchanged.

I Invisible The selected image is always invisible.

W Working The selected image is visible and is affected by the Swipe status. 
There must be at least one working layer. The last layer in the list 
cannot be the working layer since there is no layer beneath it.

S Static The selected image is visible but it is unaffected by the Swipe 
status. 
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9. Move the check for landparcels.shp to the S column to leave it dis-
played. Swipe only ortho_2006.img. 

10. Use this time to switch between modes, start / pause / stop the movie, 
and become familiar with the Swipe Multilayer functionality.

11. Zoom and pan around the imagery and analyze the difference 
between the datasets using Swipe. 

12. Close the Transition  and Clear the View.

Now we are ready to examine additional data sets.
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Exercise 3: Understanding Imagery

Objective: Students will become familiar with manipulating band combinations and working 
with image attributes.

Task 1:  Display 
Selected Informa‐
tion

We will be utilizing the spectral reflectance characteristics of known features and 
the bands measured by LANDSAT Thematic Mapper to help identify features of 
interest.

1. In a View, display subset.img using the default band combination (4, 
3, 2).

2. Change the scale to 1:50000. 

In this thematic image of soils, each color represents a different soil type. 

3. In the Bands group under the Multispectral tab, notice that the 
Common Sensor Types pop-up list displays five options: 

• Landsat 4 TM - 6 Bands

• Landsat 7 Multispectral

• Landsat 5 TM - 6 Bands

• ASTER SWIR

• Custom

Common Sensor Types

 Common Band Combinations
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4. From the first pop-up list, select Landsat 5 TM - 6 Bands.
  

5. First, familiarize yourself with the area. 

6. Within the Viewer, use the  Inquire Cursor (on the Home tab) to 
navigate to: 

47 13 40 N  123 36 58 W

7. At the coordinates defined above, you should see a distinct clearcut 
area. If necessary, use the Zoom tools to zoom in to this field. Around 
this area you should be able to distinguish a network of logging 
tracks. 

This combination is called a Near Infrared Color 
Composite and is one of the most commonly used 
combinations. Features should appear as follows:

Vegetation Red

Crops Pink to Red

Wetland Dark Red

Water Shades of Blue or Black

Urban Areas Cyan to light Green

Bare Soil Cyan to light Green

R = Red

G = Green

B = Blue

C = Cyan

Y = Yellow

M = Magenta

W = White
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Next, you will improve the appearance of these tracks for identification purposes, 
since they influence the rate of erosion in these areas. 

8. From the Bands group of the Multispectral tab, change the band 
combination to Red: 5, Green: 4, Blue: 3.  

Does this band combination improve your perception of these roads?

9. Now change the combination to Red: 3, Green: 2, Blue: 1. 

In a Classic Viewer, band combinations can be changed by 
selecting Raster  Band Combinations.

This is a Short Wave Infrared Color Composite. Features 
should appear as follows:

Vegetation Shades of Green

Crops Shades of Green

Wetland Shades of Green

Water Dark Blue to Black

Urban Areas Violet

Bare Soil Magenta or pale Pink

This is called a True Color image since we are associating 
the red color gun with the red band, the green color gun 
with the green band and the blue color gun with the blue 
band. This is similar to what the naked eye would see. 
Features should appear as follows:

Vegetation Olive Green

Crops Medium to light Green

Wetland Dark Green or Black 

Water Shades of Blue and Green

Urban Areas White to light Gray
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10. Use this tool to experiment and decide which band combination best 
displays:

• Logging Tracks __________________

• Clearcuts _______________________

11. Individual bands can often provide sufficient information. Open a sec-
ond View. 

12. With the second View selected, click the Open Layer icon . The 
Select Layers to Add dialog displays.

13. In the Select Layers to Add dialog, select subset.img image once 
more, click the Raster Options tab, change the Display As pull-
down list to Gray Scale, change the Display Layer to 1, and then 
click OK. 

14. You have displayed Band 1 of this subset image in levels of gray. On 

the Home tab use the  Link Views to Link this Viewer with the 

Viewer containing the subset displayed with 3 bands.

Does band 1 assist in the identification or enhancement task?

15. In the Bands group on the Panchromatic tab, change the Show 
Layer to layer 2. 

16. Try to determine whether this band helps in any way. 

17. Try viewing each band separately, and determining which band(s) is 
of use in identifying the clearcuts.

18. Once finished, Close the View with the panchromatic image.

Bare Soil Pinkish to light Brown 
28 Introduction to ERDAS IMAGINE Section 1: Data Visualization and Manipulation 



LANDSAT Thematic Mapper and the Electromagnetic spectrum.

Band 1, Blue, 0.45 - 0.52µm

• Mapping coastal water areas

• Forest types mapping

• Identifying cultural features

Band 2, Green, 0.52 – 0.60µm

• Distinguishing healthy vegetation

• Identifying cultural features

Band 3, Red, 0.63 – 0.69µm

• Discriminating different plant species

• Soil boundaries

• Geological boundaries

• Identifying cultural features 

Band 4, NIR, 0.76 – 0.90µm

• Vegetation Biomass

• Crop identification

• Soil / Crop and land water contrasts

Band 6, LWIR, 10.4 – 12.4µm

• Thermal analysis

Band 5, SWIR, 1.55 – 1.74µm

Band 7, SWIR, 2.08 – 2.35µm

• Moisture content of plants & soil

• Crop drought studies

• Discrimination between clouds, snow, and ice 

• Geologic rock types and soil boundaries
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Task 2:  Image Meta‐
data and Histograms

1. On the Home tab, Information group, click the  Metadata button.

This opens the Image Metadata dialog which displays information about the image 
such as projection and spatial resolution.

How many layers are in this image?

What is the projection information for this image?

What is the spatial resolution (pixel size) for this file?

You can view a graphical histogram through the Image Metadata dialog. A histo-
gram displays statistical information for each band in an image. There are three 
ways to access the histograms:

• Click the Display the Layer Histogram icon from the Image 

Metadata dialog.

• In the Image Metadata dialog, select View Histogram.

• In the Metadata dialog, change to the Histogram tab.

2. Choose one of the three methods to open the graphic histogram dis-
play window.
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The X-axis displays the range of possible brightness values. The Y-axis displays 
the number of pixels for any brightness values. If you change the layer in the 
Image Metadata dialog the histogram will update to reflect information for that 
layer.

What are the Minimum and Maximum values in this image? What is the 
Mean?

3. It is often desirable to print statistical information for an image to use 
as an aid when interpreting an image. You can do this by selecting 
File  Print or by clicking the Print button. Do not print the statis-
tics. Click Cancel.

4. Close the open Image Metadata dialog and Clear the eWorkspace 
View.
Hexagon Geospatial Customer Education Introduction to ERDAS IMAGINE 31



Task 3:  Changing 
Image Contrast 

Often a feature cannot be extracted because it displays a similar color or gray 
scale to its surroundings. Though it may contain a different DN value, it looks 
similar. Adjusting the image contrast can enhance these features.

1. Click the Open Layer icon . In the Select Layers to Add dialog, 
select subset.img, click the Raster Options tab, and enable the No 
Stretch checkbox, then click OK. 

 

2. On the Multispectral tab, select  Adjust Radiometery. From 
the Standard Streches thumbnails, find and select 
Standard Deviation Stretch.

Why did the image first appear ‘dark’?

3. Select Undo  on the Quick Access toolbar. 

4. To view the value changes that are occurring, select  Adjust 
Radiometry  Breakpoints.

By default, ERDAS IMAGINE displays an image with a Per-
cent Clip (Percentage LUT) stretch; this is how an image 
appears without that stretch. The capability of displaying 
imagery with or without a contrast stretch can be set in the 
preferences.
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5. Redo the SD stretch (Multispectral tab   Adjust Radiometry 
 Standard Deviation Stretch). Click the Apply All button in the 
Breakpoint Editor.
Hexagon Geospatial Customer Education Introduction to ERDAS IMAGINE 33



  

Linear Contrast 
Stretch

A simple way to improve the visible contrast of an image. It is often necessary to 
contrast stretch raw image data, so that they can be seen on the display.

Nonlinear 
Contrast Stretch

A way to gradually increase or decrease contrast over a range, instead of applying 
the same amount of contrast (slope) across the entire image. Usually, nonlinear 
enhancements bring out the contrast in one range while decreasing the contrast in 
the other ranges.

Piecewise Linear 
Contrast Stretch

A way to enhance a specific portion of data by dividing the lookup table into three 
sections: low, middle, and high. You can enhance the contrast or brightness of any 
section in a single color gun at a time. This technique is very useful for enhancing 
image areas in shadow or other areas of low contrast.

The Standard Deviation Stretch is what type of stretch (linear, nonlin-
ear, piecewise linear)?

6. Close the Breakpoint Editor.

7. Click  Adjust Radiometry. This time, select General 
Contrast.  
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8. Change the Method to Histogram Equalization, change the Histo-
gram Source to Whole Image, and look at the preview image.

What has this done to your image? What is highlighted? What is lost?

9. Change the Method to Percentage LUT. This is the default stretch in 
IMAGINE. 

By default, how much is clipped off of the left side of the histogram? 
The right side?

10. Adjust the thumbwheel at the top of the General Contrast Tool so that 
you can see previews of all of the contrast stretches you have 
selected.

11. Change the Method to Linear, and then set the Slope to 2.0.

12. Click the Breakpts button. 

13. In the Contrast Adjust Tool, click Apply.

What has the slope change altered in the Breakpoint Editor?

14. Set the Shift to 15 and click Apply. In the Breakpoint Editor, click 
Apply All.

The Percent Clip (Percentage LUT) stretch allows you to 
set how much is clipped off of each end of the histogram.
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What has this highlighted?

15. Close the Breakpoint Editor.

16. Reset the Slope to 1.0 and the Shift to 0. Click Apply and Close. 

17. Open a second Viewer and display tm_00.img, using the No Stretch 
option. 

18. Zoom in on the area we are studying. If necessary, link the two Views 
together in order to navigate back to that location. 

19. From the Extent group of the Home tab, set the Scale to 1:50000.

20. You can restrict the area to which a stretch is applied. From the Insert 
Geometry group on the Drawing tab, click the Create Rectangle 
icon . 

21. In the second Viewer and click and drag a rectangle over a clearcut 
area.

22. In the 2D View #2 group of the Contents pane, select tm_00.img. On 
the Multispectral tab, select Adjust Radiometry General 
Contrast. 

23. Change the Method to Linear and set the Slope to 2.0, and the Shift 
to 15, then click Apply. Click OK in the Warning dialog that appears.

Does this stretch improve the appearance of this area?

24. Try a few more contrast stretches and preview them in the contrast 
tool.

Which stretch best improved the appearance of the clearcut area?

25. Close the General Contrast tool and remove all images from the 
Viewers. Click No when asked to save changes before closing.

The Histogram Source and Apply To radio buttons are auto-
matically set to AOI.
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Exercise 4: Examining Raster and Vector Attributes

Objective: Students will examine raster attributes in a thematic image, and learn some of the 
techniques for manipulating these attributes.They will also review a stream cover-
age that was created for a study region in 1975. Using this vector coverage, you 
will visualize the sensitivity of the salmon populated streams to environmental 
changes.

Task 1:  Display 
Raster Attributes

1. Open the image soils_95.img in a View. In this thematic image of 
soils, each color represents a different soil type.

2. To determine which color represents which soil, select the 
soils_95.img in the Contents pane and then click on the Table 
tab.This displays all of the functions that can be used with Tables in 
IMAGINE.

3. Click the  Show Attributes button. This displays the Raster Attri-
butes Table below the imagery. 

4. Click on various locations within the Viewer and take note of which 
rows are highlighted in the CellArray™. Each row represents a differ-
ent soil.

5. To view a particular soil in a Viewer, place the pointer over the specific 
color patch, click, and change the color to chartreuse. This particular 
soil type is now more obvious. 
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6. To undo the changes, click the Undo button  on the Quick 

Access toolbar.

Task 2:  Selecting Soils 
Based on a Criteria

Now you will select the soils that are most sensitive to erosion.

1. In the Row group on the Table tab, click the  Criteria button. The 
Selection Criteria dialog displays. 

$”characteristics” contains humus and $”characteristics” contains fine

2. To generate the above statement using the mouse:

• Select characteristics from the Columns list

• Select the contains operator from the Compares list

• Type: humus

• Click the and button

• Select characteristics from the Columns list

• Select the contains operator from the Compares list

• Type: fine

The Selection Criteria dialog is used to build a statement for 
selection. You will assume that soils that are humus-rich 
and fine in texture, have higher erosion potential.
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3. When the statement is complete, click the Select button. All soils 
matching the criteria are selected in the CellArray. If the process was 
successful, you will notice that the CellArray has two rows highlighted 
in light blue. 

4. Click Close and in the Selection Criteria dialog.

As these are the targeted soils, you will want to mask out all others (remove the 
appearance of others from the screen). 

5. Click the  Invert Row Selection button. 

6. Click on the Opacity column and then right-click on the same column. 
Select Formula. The Formula dialog displays.

7. Type 0 in the Formula textbox. Click Apply and Close.

8. Leave one remaining View open and click the Clear View icon  to 

clear it of all images.

9. When prompted to Save Changes, Click No

Task 3:  Studying Pre‐
vious Results

You will import results from a previous (circa 1975) study done in the same area, 
which are in an Shapefile format.  

10. In a single Viewer, display soils_95.img and hydro_75.shp, making 
sure that hydro_75.shp is the topmost layer.

11. On the Style tab in the Shape group, click on the right part of the 

 Line Color button. Select the Blue color patch.

If you were not successful, check and/or correct the syntax 
of the criteria statement then click the Select button again. 

You could also right-click in the Row column and select 
Invert Selection.

If the sensitivity = 1, then the river has high potential of 
sedimentation. 

If the sensitivity index = 3, then the river has low potential of 
sedimentation.
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12. Click  Line Style and change the Line Thickness to 2. 

13. To have greater control over the styles, click the Properties button= in 
the bottom right corner if the Styles group.

14. The Line style properties dialog is displayed. Change the Width to 
1.5.

15. In the Properties dialog, click Close. Select No when prompted to 
save the Symbology.

Can you see any differences among the various branches of the 
river?

16. On the Table tab, click the  Show Attributes button. The Attri-
butes for hydro_75 dialog displays.

17. Click the  Criteria button. 

18. Use the mouse to create the following expression: 

$”SEN_IDX” = = 1 or $” SEN_IDX” = = 2

Properties
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19. Click Select. 

20. In the Rows group, click the  Unselect Rows button. 

21. Click Close in the Selection Criteria dialog, then close the Attribute 
Panel. 

It would be advantageous to distinguish between more sensitive streams. To do 
this, you will create different line types using Symbology. 

22. On the Style tab, click the  Unique Value button. The Symbol-
ogy dialog displays.

23. In the Unique Value box, click the pull-down arrow and select 
SEN_IDX from the list. 

24. Enable the Generate New Styles checkbox, then click OK.

25. Click Apply.

What do the different automatic options do? (Hint: See On-Line Help)

26. After reviewing the vector coverage on the screen, return to the Cate-

gorization group, and select  Equal Divisions.

27. In the dialog that displays, click the pull-down arrow and select 
SEN_IDX, change the Number of Classes value to 2, and enable the 
Generate New Styles checkbox, then click OK.

The selections will highlight as blue within the CellArray and 
yellow in the Viewer. 
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28. To adjust the grouping, click the Properties button in the bottom right 
corner of the Categorization group.

29. In the Symbology dialog, change the Class Name of the first entry to 
1-2 and the second to 3. 

30. Change the expression of Row 1 to: 

$”SEN_IDX” between 1 and 2 

31. Change the expression of Row 2 to: 

$”SEN_IDX” == 3

32. Click Apply.

33. To change the symbology of the different divisions, click on the Sym-
bol patch for Row 1, and select Other. 

34. Change the symbol to a Red line with a width of 2.0. 

35. For Row 2, change to blue with a width of 0.5.

36. Click Apply and Close in the Symbology dialog. Answer Yes when 
prompted whether to save the Symbology file and type 
hydro_75.evs. Press Enter and click OK.

37. Clear all open Views.

Properties
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Exercise 5: Image Mosaic

Objective: Students will use two aerial photographs for analysis and mosaic them into a sin-
gle image. 

Task 1:  Mosaick‐
ing Ortho Images

1. Display ortho_282.tif and ortho_281.img. 

2. From the Home tab, select  Swipe to examine the overlap 
between these images. 

3. When finished, close the Transition tab.

What are the projections and resolutions of each of the input images?

4. Leave the images open in the Viewer.

5. From the Raster tab, select Geometry group   Mosaic  
Mosaic Pro. The Mosaic Pro Workstation is displayed.

6. From the MosaicPro toolbar, click the Add Images icon .

7. From the Add Images dialog, select ortho_281.img.

8. Click the Image Area Options tab.

9. Enable the Compute Active Area radio button. 

What does the Compute Active Area radio button do?

10. Click the Set button and an Active Area Options dialog displays. 
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11. Specify that the Boundary Search Type is to be computed from the 
Corners of the image.

12. Select Crop Area and change it to 5% in order to eliminate unneces-
sary fiducial marks on the edges and then click OK.

13. Click OK in the Add Images dialog. 

14. In the Add Images dialog, click the OK button and a graphical outline 
representing your image displays in the Mosaic Tool.

15. Repeat the Add Image process for ortho_282.tif, remembering to 
select the Image Area Options tab and setting Compute Active 
Area to Corner and deselecting the Crop Area.   

16. Click in each of the Vis cells to place checkmarks there. 

17. Click the Show Images icon  to display all of the images in the 
workspace.

To delete an image from the Mosaic Tool, highlight the 
image in the CellArray, right-click in the Order column, and 
click Delete Selection.

Images could have been taken on different days, times or 
seasons. This will lead to images with different contrasting. 
To compensate this, the Mosaic Tool provides Contrast 
Matching options.

Only those images that have a  in the Vis column will be 
displayed.
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18. Click the Color Corrections Options icon . A Color Corrections 
dialog displays.

19. Enable the Use Histogram Matching checkbox, then click OK.

Which image will be the reference in the histogram matching? 

How can we change the reference image?

How does the reference image affect our output mosaic?
Hexagon Geospatial Customer Education Introduction to ERDAS IMAGINE 49



Task 2:  Creating 
Seamlines

Seamlines are used to define where the seam between the images will be made.

1. Ensure that the Display Seam Polygons button  is toggled on.

2. Click the Automatically Generate Seamlines icon . 

3. Enable the Weighted Seamline option and click OK.

4. Zoom in on the seamline.

5. Click the Edit seams polygon icon .

6. Digitize a polygon around a portion of the seamline. See below. The 
side of the seamline from which the polygon originated is the one that 
will increase in size when the polygon is completed.
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7. Move along the seamline and make any additional changes where 
necessary. The seamline will be displayed in the mosaic canvas.

8. From the Mosaic Pro Toolbar, click the Set Seamline Function 

icon . This allows us to set the function used to handle the areas 
within the overlap.

1

2

3
4

5

6
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9. Enable the Feathering radio button. 

10. Set the Distance to 50.

11. Click OK.

Task 3:  Defining the 
Output

The Mosaic Tool allows you to define the extent of your output through the use of 
an AOI. This can save disk space and eliminate the need for subsetting at a later 
stage.

1. In the eWorkspace Viewer containing the images, click on the Draw-
ing tab.

2. Click the Create Polygon icon . Create an AOI polygon encom-
passing the Wynoochee River, and a large percentage of the 
clearcuts on either side of the river.  

3. In the Mosaic Pro toolbar, click the Set Output Options icon . 
The Output Image Options dialog displays.

The feathering operation could be used to blend the transi-
tion between the two images. More feathering occurs at the 
seamline and its intensity decreases as you move away 
from the line.

The Wynoochee River meanders from top to bottom on the 
right side of the image.
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4. In the Output Image Options dialog, change the Method to User-
defined AOI, then click the Set Output AOI button.

5. Select Viewer as the AOI Source, ensure that the AOI is selected in 
the Viewer (it has blue handles around it) and then click OK.  

The Mosaic Pro Tool has (by default) adopted the projection 
of the reference image (first image in the mosaic list) for the 
output. If you need a different output projection, you can 
change this by using the Change Output Map Projection 
button.
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6. Click OK in the Output Image Options dialog. 

7. Click on the Display Output Area Boundaries button . You will 
now see a magenta graphical outline that defines the extent of the 
output.

8. In the Mosaic Tool menu, select Run Mosaic . This displays an 
Output File Name dialog. 

9. In the File Name text box, type mosaic.img.

10. Click the Output Options tab and enable the Stats Ignore Value 
checkbox.
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11. Click OK.  

12. When the Mosaic Job State reads Done, click OK to complete the 
process.

13. In a Viewer, display your output file. Use the Interactive Zoom tools 
to determine the accuracy and contrast matching of your mosaicked 
overlap area.

14. Close the Mosaic Pro Tool. Save the output Project file as 
mosaic_ortho.mop. 

Ignoring zeros in the Stats calculations, prevents the back-
ground values from skewing the image histograms and 
causing the image to appear ‘washed-out’.
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15. Close any open Viewers.

We defined the output image area using an AOI. What are other ways 
of defining the output area?
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Challenge 2: Creating a Map Composition

Objective: Students will create and edit a map composition that will be part of a preliminary 
presentation to local politicians and business leaders.

Task 1:  Setting 
Map Preferences

1. Open the Preference Editor by selecting File  Preferences.

2. Expand Applications and select Map Composer

3. Change the Default Map Directory to the Data directory.

4. Change the Default Plot Directory to the Outputs directory.

5. Click Save and Close.
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Task 2:  Prepare Data 
for Composition

1. In a View, display the image ortho_2009.ecw. (You may need to 
change the Files of Type filter to ECW.)

2. Right-click in the View and select Fit to Frame.

3. In the same View, select File  Open  Vector Layer...

4. Browse to your default directory and select (do NOT double click!) 
landparcels.shp.

5. Click the Vector Options tab and check Use Symbology. Click Set...

6. On the Choose Symbology button, select parcels_by_area.evs. 
Click OK.
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7. Click OK on the Select Layer to add dialog. The Vector Layer is dis-
played on top of the ortho raster with symbology already applied to it.

8. From the Home tab, click  Add Views   Create New Map 
View. An empty map composition is created in the Map View.

9. On the Layout tab, in the Map Template group, select the 

 Geospatial Analysis template.

10. Double-click on the empty map frame (the area with the red X).

Empty map frame
double-click
to add data
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11. Click inside the View containing the data we want to load in the map. 
The Map Frame dialog is opened, along with a box indicating the por-
tion of the data that will be loaded in the map frame with the default 
settings.

12. Select the Change Scale and Map Area (Maintain Frame Area) 
radio button.

13. Drag the box in the 2D View to encompass the majority of the image. 
Enlarge or shrink the box by dragging the corners. Some parcels will 
not be included.

14. When satisfied, click OK on the Map Frame dialog. 
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All of the data displayed in the 2D View is loaded into the map composition.

15. Close the 2D View.

16. Save your map composition as 2009_subdivision.map.
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Task 3:  Adding a 
North Arrow, Legend, 
Grid Lines and Title

Next, you will create a map legend.

1. In the Insert Map Element group of the Drawing tab, click the 

 Legend button.

2. Click in the white space between the scale bar and the Image Loca-
tion map.

3. Follow the prompt and select the main map frame that contains the 
landparcels.shp file. The Legend Properties dialog displays.

4. In the Basic tab, using LMB + Shift, select Rows 2-4.

5. Select the Title tab and change the Title from Legend to Parcels by 
Area.

6. Click Apply and Close.

7. Click the newly created legend to select it. Resize and move the leg-
end so that it fills in the available white space.

8. .Make room for the Legend by moving or deleting text from the bot-
tom of the map canvas.
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9. With the legend selected, in the Arrange group, select Ungroup 
twice.

10. Select only the word Symbology and click the Delete icon  in the 

Edit group.

11. From the Modify group, click the Select menu button and choose 
Select by Box.

You can also remove the selected annotation by pressing 
the Delete key on the keyboard.
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12. Draw a bounding box around the remaining legend parts.

13. Click the  Group button in the Arrange group.

14. At the top of the map, click on the Title of Map, Region text to select it. 
Delete the existing text.

15. Click the Create Text Annotation icon .

16. Click on the canvas where the text was deleted.

17. Type Bradshaw Park Subdivision. Press Enter.

18. In the next line, type Cherokee County, GA.

19. Use the tools in the Font/Size group to change the size, color, and 
style of the font.

20. Now that your map composition is finished, click the Save icon .
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Task 4:  Send map to a 
PowerPoint slide

Now we will send the map to a PowerPoint slide deck for our presentation.

1. From the Manage Data tab, select Office Tools  Send to Power-
Point  New Presentation.

2. Click Yes if you see a dialog asking to Save All Layers.

A new PowerPoint presentation is created with the map inserted into the first slide.

3. Clear any open Views and dialogs.
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